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This procedure describes a simple procedure to create a large-format poster.  This procedure is tailored 

to creating and printing a poster that is 36 inches wide or 42 inches wide.  The poster length, the other 

dimension, can vary.  For example, a poster can be created that is 36 inches tall by 48 inches wide.  Or, 

posters can be created in any size as long as the lesser dimension is 42 inches or less.   

Tool:  The procedure is based on using Microsoft Excel as the “paper” sheet.  Other software 

applications, such as Adobe Photoshop, can also be used to create these large-format posters.   

Procedure:  This procedure is based on Excel for several reasons.  First, Excel is part of Microsoft Office, 

which every student should have installed on their computer.  A complicated program, such as Adobe 

Photoshop, does not have to be used, although it could be used if desired.  Second, the Excel worksheet, 

which is aligned in rows and columns, provides a convenient “grid” layout useful in aligning objects 

(pictures, clip art, text boxes, etc.) onto a page.  Third, unlike Word or PowerPoint, Excel page size can 

be adjusted such that a single worksheet page, which I will call the “drawing canvas”, can accommodate 

large size posters.  Lastly, Excel 2010 can save the worksheets in PDF format which is compatible with 

the HP DesignJet 4520mfp HPGL2 Printer available to IU Kokomo students.  All-in-all, this resource 

provides an easy and simple opportunity to students who want and need to produce high-quality 

presentations.  The process documented in this tutorial to create high-quality presentation posters is a 

simple and straight-forward process!  The goal of this tutorial is to help you create and print a large-

format poster, and do it right the first time, because of the cost to print the poster!   

 

Cost:  Posters printed on the HP DesignJet 4520mfp HPGL2 Printer are expensive to print.  For example, 

a 36” by 48” poster, printed on 36” wide paper is 48” long.  The cost to print the 48” long poster is $0.33 

per linear inch (33 cents per inch).  For a 36” by 48” poster, this is $15.84 to print.  So, the cost to print a 

single poster of this size represents approximately 60% of a student’s semester print quota of $26.00.   

 

Please ask for a Computer Services Helpdesk Consultant to check your print settings *before* printing to 

ensure that your poster is printed correctly the first time.  Dollars *will not* be refunded for 

composition and authoring errors on the poster; dollars will *only* be refunded for mechanical printing 

problems such as a paper jam or “out of ink”.  

Some suggestions: 

1. When ready to print, please ask a Helpdesk Consultant for assistance.   Computer Services will only 

refund value into a student’s Print Quota because of equipment issues (jammed printer, low/empty 

ink and toner, systems issues).   Refunds are not granted because of user problems (printout is 

wrong size, printout contains typographical errors and misspelled words, “Oops! I didn’t mean to 

print that yet!”)  Make sure the poster is perfect before printing.  
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2. Students working together as a group on a semester project:  Students working as a group can 

calculate the cost to print the poster, divide the cost equally among all of the students in the group 

to share the cost, and then apply the poster cost to one student’s “Student Paid Pages” GoPrint 

account and print the poster from that student’s “Student Paid Pages” account. 

3. Students working alone:   Students can cover their own printing cost by adding funds to their 

GoPrint “Student Paid Pages” account through the GoPrint Value machine in the Library Copy Room.  

Students can add value to their own “Student Paid Pages” account.   

 

So, let us begin! 

Open Excel. 

 

The Excel worksheet will be configured to become the “drawing canvas”.  The term “drawing canvas” is 

used in this tutorial to indicate the large-format page of paper that will become the “poster”.    
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So, first it is necessary to configure the Excel worksheet to have a page size equal to the page size of the 

poster/display that will be printed on the HP DesignJet 4520mfp HPGL2 Printer and to set up the 

worksheet printing properties correctly.    

1. Open the File menu and click the Print… menu item.  

2. In the Printer field, set “target” printer to KO-LC-INDIGO on ko-printsrv. 

 

Note:  The printer KO-LC-INDIGO might not be installed on the workstation you are using or your laptop.  

Please come to the Computer Services Helpdesk in the Library or the IT Support Center for assistance in 

getting the printer KO-LC-INDIGO installed.   

Note:  The printer KO-LC-INDIGO is installable from campus only.  It cannot be installed off campus.  

Therefore, this procedure can only be performed on campus.  
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3. Click Printer Properties. 

 

4. On the  \\ko-printsrv\PRINT-LC-INDIGO Properties dialog box, click Custom… button to open the 

Custom Paper Sizes dialog box. 

 

5. On Custom Paper Sizes dialog box, ensure that English units are selected, and then set width (   ) to 

48”, and height () to 36” inches. 

Note:  Standard cardboard tri-fold poster display boards are 36” (tall) by 48” (wide).  The 

HP DesignJet 4520mfp HPGL2 Printer can print on 36” roll paper.   It can also print 42” 

width paper, but for a 36” (tall) by 48” (wide) display board it is most efficient to print 

on 36” wide paper.  

6. Click OK to close the Custom Paper Sizes dialog box. 
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In the \\ko-printsrv\PRINT-LC-INDIGO Properties dialog box, verify that the correct 

dimensions are shown in the Size is: field, as shown above. 

7. Click OK to close the \\ko-printsrv\PRINT-LC-INDIGO Properties dialog box. 

Excel is now configured to have a worksheet that will be a 36” (tall) by 48” (wide) printable page. This 

can be verified by looking at the Print page in Excel, as shown below: 
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8. To display the Excel worksheet “drawing canvas” page, click the Home tab.   

9. Set view scaling to be approximately 15 percent.  Click the View tab. Click the Zoom button to 

display the Zoom dialog box.  

Because the 36 x 48 in. worksheet “drawing canvas” is so large, it will be necessary to 

set the zoom magnification in Excel to a percentage that will allow viewing of the entire 

worksheet “drawing canvas” page on the computer monitor.  However, while working 

on the poster, the zoom magnification can be set/reset to any value necessary for 

placement and adding content.  Knowing how to set/reset the zoom magnification is 

important to zoom in to allow placement and alignment of objects on the worksheet 

“drawing canvas”, but also to zoom out and see what the overall poster product will 

look like when finished.   

Printer = PRINT-LC-INDIGO on ko-printsrv 

Page size = Custom 1:   36 x 48 in.  
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10. After setting the Custom: zoom size to be approximately 15 percent, click the OK button to apply 

the zoom setting.  Now the Excel workbook should look like this… 

 

11. The worksheet “drawing canvas” pages are in portrait orientation as shown above.   

This orientation may be what you want, but if you need the pages to be in landscape orientation, it 

can be easily changed.   

 

 

Portrait 

orientation 
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12. If the “working page” is oriented incorrectly, the orientation will have to be reset.  On the Page 

Layout tab, in the Page Setup group, click the Orientation button and select the other orientation 

(Portrait or Landscape).  Landscape orientation may be the logical orientation, based on the final 

poster design.  After changing the worksheet “drawing canvas” page to landscape orientation, it will 

appear as shown below.  

 

13. When placing items on the page, it may be helpful to see the entire “drawing canvas” page on the 

screen.  The Zoom setting can be increased (Zoom in) or decreased (Zoom out) when it is necessary 

to adjust the placement of an object on the page.   Change the scale of the Worksheet (Zoom out) 

using the Zoom control in the lower right-hand corner of the Excel window. 

14. It may be helpful, but it is not necessary, to set the Excel worksheet grid settings to size(s) that allow 

the grids to be “square”, i.e. vertical and horizontal dimensions of each cell are “square”.  The 

purpose of this step is to set up the worksheet to “look like” graph paper to assist in alignment of 

graphic and text objects on the large-format paper sheet.  A suggested setting is to set the row 

height to 15 (= 20 pixels) and column width to 2.14 (= 20 pixels).  To change the row height and/or 

 

Landscape orientation 
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column width, click the Select All Cells button on the worksheet.  On the Home tab, in the Cells 

group, click on the Format button.  In the menu that displays, both the row height and column width 

can be set.   

 

15. Finally, delete all Excel worksheets within the workbook, leaving only worksheet #1 (Sheet 1).  Click 

on the “Sheet2” tab, right-click and click on Delete in the shortcut menu.  Do the same for the 

“Sheet3” tab.  Only “Sheet1” should be remaining.  

Select All Cells button 

Format Cells button 
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At this point in this tutorial, the Excel worksheet is set up to be 36” x 48”, and the Excel grid settings are 

set to be “square” cells to aid in positioning objects on the page.  

 

The next step is to add content to the poster.  

Add content to the page (worksheet).   

1. Add screen shots 

2. Add SmartArt 

3. Add Shapes 

4. Add Pictures or Clip Art 

5. Add textboxes (in Excel) 

6. Add all other objects 
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Authoring and Composition Guidelines… 

Text sizing guidelines:  Use a size font (font height) that is easy to read from a distance.   

Viewing distance from the poster Recommended font size 
Reading distance (12-24 inches) 18 point font (1/4 inch tall text) 
3 to 5 feet from the poster 36 point font (1/2 inch tall text) 
10 to 12 feet from the poster 72 point font (1 inch tall text) 

 

 Text font guidelines:  Use a font that is easy to read, such as: 

Arial 
Calibri 
Times New Roman 

 

If you need a more professional font, perform a readability test.  Print something out on standard size 

paper using the font style and size that you need and then try reading it from the proper distance.  

Check readability.  Recognize that fancy or “scripty” fonts cannot be easily read from a distance.   

 

Pictures:  Consider adding picture styles and shadows to enhance the appearance of the pictures. 
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After adding your pictures and content onto the Excel worksheet, your poster will look something like 

this… 

 

 

Now, save the Excel workbook in PDF format.  Note:  The HP DesignJet 4520mfp HPGL2 Printer is 

capable of printing PDF files.  Saving the Excel workbook file in PDF format allows for printing directly to 

the HP 4520.   

Printing… 

1. Open the document in Adobe Reader.  
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2. In the File menu, click Print...  

3. In the Printer group, click the printer list and select the \\ko-printsrv\PRINT-LC-INDIGO printer.  

 



Tutorial: How to print poster-sized printers on the HP DesignJet  4520mfp HPGL2 Printer 

CSER “How to” Print a poster-sized printout on the Large-Format Printer  September 23, 2010 
Indiana University Kokomo Page 14 of 17 Revision 4 
Author:  Gregory M. Ogle, Coordinator of IT Training and Consulting Services 
Filename: CSER How to – Printing a poster on the HP DesignJet 4520mfp printer (INDIGO)_r4.docx 
 

 

4. On \\ko-printsrv\PRINT-LC-INDIGO Properties dialog box, click the Properties button to display the 

printer Properties dialog box.  You will need to configure Adobe Reader to print the poster. 

 

5. Click the Custom… button to display the Custom Paper Sizes dialog box.   

Notice that the 

dimensions of the 

poster in this print 

preview are incorrect.  

We will fix these now.  
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6. On Custom Paper Sizes dialog box, ensure that English units are selected, and then set width (   ) to 

48”, and height () to 36”.  Leave “English” selected as the units.  

 

7. Click OK to close the Custom Paper Sizes dialog box.  

 

8. Make sure, in the\\ko-printsrv\PRINT-LC-INDIGO Properties dialog box , that the size of the page is 

correctly display in both the Paper Options Size is: field, and beneath the print preview image.   

9. Print quality:  On the , there are several choices for print quality – Fast (draft), Normal (final), and 

Best (enhanced): 

Normal (final) mode will cause the printer to print at normal speed, but there may be 

some degradation of the images, including faint lines as a result of print head 

movements across the page.  

This is the 

“Autorotate” 

checkbox! 
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Fast (draft) mode will cause the printer to print at high speed, but the image will be 

faint and of poor quality.  This mode should only be used for checking placement of 

objects on the page.  It should not be used for the final product. 

Best (enhanced) mode will cause the printer to print at a slower speed, but the image 

will be very high quality, with no visual degradation.  Images printed in “Best” mode will 

be near photographic quality.  

Note:  Because the cost to use the printer is based on the price per foot of paper used, it 

is recommended that Best (enhanced) mode be used for the final poster product.  

10. Uncheck the Autorotate checkbox, if necessary to rotate the poster so that the “width” is shown as 

either 36” or 42”, depending on the size of the poster being printed.  This dimension should be the 

horizontal dimension.  Study the dialog box shown below for clarification.  Make sure the horizontal 

dimension matches the width of printer paper being used.   Check or uncheck the Autorotate 

checkbox to make the display correct. 

11. If all parameters are correctly set, then click OK to close the \\ko-printsrv\PRINT-LC-INDIGO 

Properties dialog box.  

12. In the \\ko-printsrv\PRINT-LC-INDIGO Properties dialog box, leave the Auto-Rotate and Center 

checkbox checked, as shown below.  

 

13. Verify that the dimensions of the page are properly shown in the Print dialog box preview.  

Leave this Auto-Rotate and 

Center checkbox checked.  
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14. Ensure that the Print Range is set to “All”.  

15. Ensure that the number of copies in the Copies field is set to “1”.  

16. Click OK to send the poster to the HP DesignJet 4520mfp Printer/Plotter and close the Print dialog 

box. 

Finally, your poster must be released to the HP DesignJet 4520mfp Printer/Plotter (INDIGO) through 

GoPrint. 

Log into GoPrint and release the poster to be printed. 

 

Note:  If you have insufficient funds in your GoPrint print “Quota”, the poster will not be released to the 

printer.  In this case, additional funds must be added to your Student Paid Pages GoPrint account, and 

the poster printed from that purse (account).   Remember, the cost to print on the INDIGO printer is 

$0.33 per linear inch of paper (33 cents per inch).  A 36” by 48” poster will cost approximately $15.84 to 

print.  

Please come to the Computer Services Helpdesk or the IT Support Center for assistance.  

The paper width dimension 

goes here…  either 36” or 

42”, depending on the size of 

paper being used.  

 

Note: The dimensions of the 

poster preview are now 

correct.   


